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1 NIMS, ICS and interTRAX™ Command

NIMS

The National Incident Management System (NIMS) is a national approach to incident
management. One of the components of NIMS is Command and Management which is based in
part on the Incident Command System (ICS).

ICS

The Incident Command System can be used for planning and operation of any type or size
incident both emergency and non-emergency. Logistical and administrative support components
ensure that the tactical objectives can be met. Personnel from a variety of agencies work
together using a common management structure minimizing the duplication of efforts.

An important component of ICS is the Check-in process which ensures resource (personnel and
equipment) accountability, allows for the tracking of resource assignments and reassignments
through the demobilization process, and provides information should the Incident Commander
(1C) need to locate personnel in case of an emergency. Resources that have not yet received their
tactical assignments are positioned in the Staging Area.

ICS uses distinct titles which have no correlation which the administrative structure used by each
agency. The Incident Commander is the position that is always staffed. The IC may delegate the
position to another person.

Operating under the IC are 4 General Staff Positions and 3 Command Staff Positions as listed
below and shown on the Command Chart. It is important that supervisors manage and
communicate with their subordinates, which is best accomplished when the Span of Control is
between three and seven.

Command Staff | COMMAND
Safety Officer
Liaison Officer

Public Information Officer L

General Staff

Operations Section Chief }

Planning Section Chief

Logistics Section Chief : s :
OPERATIONS

FINANCE/
ADMINISTRATION
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interTRAX™ Command

The interTRAX™ Command software provides a method, at an incident, for Command to operate
a real-time Electronic Incident Command board and monitor multiple mobile units. The display
allows Command to use the Incident Command Organizational Chart to track all assignments
and resources. Note: It is important that an electronic accountability system function
simultaneously with a manual system.

The Scenario using interTRAX™ Command section describes the software operations.
The scenario below includes the responding resources and their assignments. It includes, 1

department, 9 responders, and 4 pieces of equipment all of which are reflected in this Electronic
Incident Command Organizational Chart

B CommandPost

0 - Responders 0 - Responders 1-Responders (3}

0 - Equipment 0 - Equipment 1-Equipment {4}
0 - Pstients 0 - Patients 0 - Patients {0}

B Lawiis, Cad
WRMFD CL Suburban [C1-05]

B Atack Group

0 - Responders (4] 0 - Responders (3} 1-Respondars (1}

0 - Equipment {1} 0 - Equipment {1} 1-Equipment {1}

0 - Patients {0) 0 - Patients (0) 0 - Patients (0)

@ MFD-E1-01T1(a) | B £ MFD-WEL-01-T3MW (3) ) Hodoe, Howard

a Hodge, Helen WM FD-TW2-03-T1 [MFD-TW2-03-T1]
a Haogg, Jean
A sharpe, Bily
W MFD-WEL-D1-T3NW [MFD-WEL-01-T3MA]
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2 Scenario using Mobile & Command Software

This section describes the Mobile and Command software operations. The next chapter
contains actual barcodes used in this scenario which may be used with two Mobile Units
with Mobile software and a laptop computer with Command software for training. Each
time you scan or sync in this scenario you are given a number that corresponds to an

area within the barcode section. €.(Q., 1 (Red —10C), 2 (Blue & Italicized -
Redrock Chief)

The information regarding the functioning of the software and screen shots are provided
throuahout this section. A scenario has also been included and it anpears in text boxes.

»Prior to the incident, at the beginning of the shift,
the IC forms a Company by entering Engine 1 (MFD-E1-01-
T1) and 4 responders into the Mobile software. The IC

scanned the Equipment barcode and formed a Company.<« 1

Note: The advantage of using Company Tracking is that the
Resources within the Company will be moved as a Company - there is
no need to scan each Resource separately. Companies may be formed
prior to responding to an incident, prior to starting an incident or
during an open incident.

FORM A COMPANY

1. Scan 3. Form a Company 4. Company appears
with equipment

- M MFD-E1-01-T1
(7) You have scanned an
. " eguipment barcode,
2. EqUIpment barcode ) Do you want to form a
canpany’y?
| Yes | | No ‘
s 3 ‘l‘- Moosewood Fire Department
MFD-E1-01-T1
4 MFD-E1-01-T1
[zt i ORI
Roster | ICS | EMS | Roster | ICS | EMS |
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6. Personnel Barcodes 7. The Company appears fully

5. Scan populated and stored on the Roster

Moosewood Fire Department

e =}
=R Y MFD-E1-01-T1)|
Nick DeRosa B MFD-E1-01-T1
?é%‘?éﬁ%%ﬁ%‘ DeRuosa, Nick

Wentworth, Muriel
Smith, George

H Earley, Terry

liE

Roster | ICS | EMS |

The Scenario

»Moosewood Fire Department is dispatched to a structure
fire at 300 South Summit Street at 6:16 PM on March 30,
2008. The Chief responds in his Command Vehicle (MFD-
C1-03) and one Company (4 responders) respond 1In an
Engine (MFD-E1-01-T1).

The Incident Commander (IC) has a Mobile Unit (MFD_1) and
the Command software on a laptop in the Command Vehicle.
He also has a Manual Accountability Board.

When the IC arrives on the scene he assesses the
situation and gives iInstruction to his subordinates. The
subordinates place their accountability tags on the
Manual Accountability Board and go to work.

The Dispatch Center contacts the IC to advise him that
two additional Moosewood units, a Water Tender (MFD-TW2-
02-T1) and a Wildland Engine (MFD-WE1-01-T3NW) are en
route to the scene.

The IC turns on his Mobile Unit and boots the Ilaptop
computer <«
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»The IC starts the Mobile software. He clicks on Menu->
New Incident. The New Incident screen appears and the IC
types in an incident name and chooses a type from the
dropdown. The IC taps on all of the boxes for the
Company that he had stored iIn the Roster. He then clicks

on OK. <«

vy MOBILE

s MOBILE

New Incident

8 Name  [gummit |

+ B MFD-E1-01-T1 Mumber - Fire |
Type  [Fire -|
Training [_]

New Company []#®% MFD-E1-0 I!.—Tl
Mew Incident DeRosa, Nick
Earley, Terry

RIRIRIE]

MNew Medical Incident wentworth, Muriel
Settings... Smith, George
Time...

Sync

About

Me|

»The main screen appears with the Off Scene and On Scene
Assignments. The Company appears 1i1n the On Scene

Assignment. «

‘s | MOBILE o 4 14T [ok "y MOBILE
Q, Timer [I0:00:00] paR Q, timer PO0DD0] par [4
Assignment [On Scene - Assignment |On Scene v|
[T Off Scene (00 [ Off Scene (D)
+-[[) On Scene (4) SRElOn Scene (4]
= 8 MFD-E1-01-T1 (4)
DeRosa, Mick

Earlery, Terry
Wientworth, Muriel
Smith, George
M MFD-E1-01-T1 [MFD-E1-01-T

4 I [ T»

Menu | Sync

Menu | Sync
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»The IC scans the On Scene barcode or selects On Scene
from the Assignment dropdown and scans his equipment and
responder barcodes. All of the equipment and responder
barcodes are hanging on the Manual Accountability Board. <«

2
Note: Manual Accountability continues in
parallel with the Electronic Accountability

»The main screen appears with Responders, Equipment and
the Company in the On Scene Assignment. «

Q Timer W PAR _

Assignment [On Scene -]

(= Off Scene D)

Yy Lewis, aI
B MFD C1 Suburban [C1-06]
+ 8 MFD-E1-01-T1 (4)

Menu | Sync

»The IC starts the Command software. <

Click on the icon installed on the desktop

COMMARD

OR

Start->Programs—->Salamander->Command
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»The IC clicks ON File=>New Incident. «

& Salamander Command
File | Incident Report View Help

New Incident.,., ‘

Open Incident. ..

Options...

Export
Irnpart

Exit

Ready | e, 100% - | oo:oo

»The Start Incident screen appears. <

Fl
6 -- START INCIDENT --
BACK  SAVE
NEW |FIND |
Run Number | I Training
Organization |Mooswood Fire Department Location | -
Narme |Fire 300 South Summit Street Type IFire j
startDate | 2/25/2010 x| izs7 Endpate | /5010 x| [1357

NOTE: The Start Date and Start Time reflect the information from the
current settings on the Command computer.

»The IC types in the Incident Name: Fire 300 South Summit
Street. The IC chooses the Incident Type: Fire and clicks
on Save. The IC may assign an Incident Number Ilater

should he choose. «
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»The Command Main Screen appears. <

 COMMAND - Fire 300 South Summit Street [ =] |

Fle Incident Report ‘View Help

Elrost | Huwe | Dwowe |

=i
0 - Responders 0 - Responders
0 - Equipment 0 - Equipment
0 - Patients 0 - Patients

4 o1
I Total PAR O Total Patient Count O
s B B W BOT. L

ASSIGNMENT COMPANY RESPONDER EQUIPMENT PATIENT NOTE TIMER

Responder Company’ Equipment Red RCILNV Green LflEY Black

Ready w, | 100% 0003 L

»The IC syncs the MU to Command. < 3

?} | MOBILE

[ Off Scene (0)
=13 O Seene (5)
B Lewis, Carl
M MFD C1 Soboeban [C1-06]
+l MFD-El@ (4)

Menu | 9end data
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to Command. «

often the Mobile Unit’s should be synced.

»Following the sync of the MU the IC assigns the mobile unit

Note: A policy should be in place that specifies how

x
@ -- ADD DEVICE INCIDENTS --
BACK SAVE
Device Name | Device UID | Incident 1D | Incident MName | Incident Number| In Progress |
MFD_55 001346E604EBO1029EFFF... 2 Surmmit Fire True

The first time an MU
is synced the Add
Device Incidents
screen will appear.
The MU that is
being synced is
identified by the
Device Name. The
Name and Number
displayed is the MU
information and
need not match what
is in Command.

»The IC checks the box for the Mobile Unit MFD 1 and

clicks on Save. <«

»Dispatch notifies the IC that one ambulance and 2 law

enforcement units are in route. <«

»The IC views the Layout Area of the main screen of

Command . <

1 - Equipment  (2) 0 - Equipment

B# MFD-E1-01-T1 (4)

a DeRosa, Mick

The top of the On Scene box lists the
L - Responders (5) 0 - Responders TOTAL number of Responders,
Equipment, and Patients. The lower

0 - Patient 1] 0 - Patient "

e © - half of the box lists the Responders,
8 evis, Car Equipment and Patients that are in the
W MFD C1 Suburban [C1-06] On Scene assignment.

8 earley, Terry The top of the Company box lists the
& smith, George TOTAL number of Responders and
& wentworth, Murie Equipment in the Company. The

[ MFD-E1-01-T1 [MFD-E1-01-T1] lower half of the box lists the

Responders and Equipment.
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»The I1C will function as the Incident Commander and the
Company will be working in Fire Attack. The IC scans the
Command Post barcode and then his vehicle and responder
barcodes. He then scans the Fire Attack Group barcode and

scans the Equipment/Company barcode. < 4

»The IC Syncs the Mobile Unit. <4 5

o'; MOBILE

Q, Timer [0000:00) par [5 ]

Assionment [Fire Attack Group -

Lenwis, Carl
M MFD C1 Suburban [C1-06]
=1 Fire Attack Group (4)
+- 9 MFD-E1-01-T1 (4)

Menu | Sync

»The IC views the Layout Area of the main screen of
Command . «

0 - Responders 0 - Responders 0 - Responders  (4) 1 - Responders (1)
0 - Equipment 0 - Equipment 0 - Equipment (1) 1 - Equipment (1)
0 - Patients 0 - Patients 0 - Patients (0) 0 - Patients (0)
E@ MFD-E1-01-T1 (4) B Lewis, carl
a DeRosa, Mick MFD C1 Suburban [C1-06]

ﬁ Earley, Terry
a Smith, George
a Wentworth, Muriel

B MFD-E1-01-T1 [MFD-E1-01-T1]
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0 - Responders 0 - Responders
0 - Equipment 0 - Equipment
0 - Patients 0 - Patients

»The 1C clicks, drags, and drops
the Fire Attack Group on the
Command Post. The connection is
illustrated by a flowchart
connector depicting the management
structure. The total number of
Responders and Equipment under his
command appears in the ( ). <

B Command Post

1 - Responders (5)
1 - Equipment {2)
0 - Patients {0)

a Lewis, Carl

MFD C15uburban [C1-06]

|~ | Fire Attack Group
0 - Responders (4)

0 - Eguipment (1)

0 - Patients {0}
IB@ MFD-E1-01-T1 {4)
B DeRosa, Nick

a Earley, Terry

ﬁ Smith, George

B wentwarth, Muriel

W FO-E1-01-T1 [MFD-E1-01-T1]

»The IC clicks on the Timer icon and drags and drops it
on the Fire Attack Group. He adds the note “Attack
started” and clicks on Save. The Clock representing the
Timer appears in the upper right hand corner of the Fire

Attack Group box. <

5 @ -- ADD TIMER --

BACK  SAVE

MNote

IAttack started

) COMMAND |

Total Time {Minutes) 1st Warning (Minutes) 2nd Warning (Minutes)

-

¥ alarm Sound

.= Fire Attack Group
0 - Responders (4)
0 - Equipment (1)
0 - Patients {0)

o
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»The Moosewood Water Tender arrives with one Responder.
The 1C gives the Responder his assignment and then scans
the Water Supply Group assignment barcode, the Equipment

barcode and the Responder barcode. <€ 6

Q, Timer [00:00:00] par 6 |

Assighment |Water Supply Group v|

|5 Off Scene (0)
=] Or Scene (6)
+-[7) Command Post (1)
+-[7) Fire Attack Group (4)
= wWater Supply Group (1)

ﬁ Hodge, Howard

B MFD-TW2-03-T1 [MFD-Ti2-

4 Il | [ »
Menu | Sync

»The Moosewood Wildland Engine arrives with three
Responders. The 1C gives them their assignment as a
Company . He wants to place the Company iIn the roster.
He taps on OK In the upper right hand corner and closes
(not ends) the 1incident by tapping on NO on the End
Incident screen. He scans the equipment barcode and taps

on YES to form a company. < !

Q, Timer |00:00:00| paR |6 &

Assignment |Water Supply Graup - o

S ( =% You have scanned an
(3) Do you want to end the ' equiprnent barcode,
current incident? Do you wwant to form a
Company?

< i T Roster | ICS | EMS |
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»He scans the

reopen. € /

responder

barcodes.

He /highlight the
incident and taps on the icon in the upper left corner to

v MOBILE

+ 5% MFD-E1-01-T1
-5 MFD-WE1-D1-TINW
M MFD-WE1-01-T3NW
Hodge, Helen
Hogg, Jean
Sharpe, Billy

Roster | IcS | EMS

Roster | ICS | EMS

» He taps on Menu->Add->Companyto add the Company. He taps
on all of the boxes for the Company and then clicks on

OK. «

s |MOBILE

Q rimer par b

Assignment |Oﬂ Scene

(= Off Scene (D)
+-[ On Scene (6)

Add »
Details *»
Eind

New Company

Company

Assignment

Menu| | Sync

vy MOEILE

=[] MFD-WE1-01-T3NW
[ MFD-WE1-D1-T3NW

:

Hodge, Helen
Hogg, Jean
Sharpe, Billy

Can

Menu | Sync

15

s& |MOBILE 42306 |ok
Q, Timer [00:0000] par [8 ]

Assignment |Oﬂ Scene

Off Scene (0)
= On Scene (9)
+-[ Command Past (1)
+-[7) Fire &ttack Group (4)
- B MFD-WEL-01-TaNW (3)

Hodge, Helen
Hogg, Jean
Sharpe, Billy
B MFD-WE1-01-T3NW [MFD-w|
+-[ Water Supply Group (1)

4 [»

Menu | Sync

XV VU OUTTIRi U T YoV & (&
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»The IC scans the Ventilation Group barcode and then
scans the Equipment/Company MFD-WE1-01-T3NW barcode. <« 8

‘s |MOBILE ¥ o 3:16 ok

Q, Timer [0000:00| PaR [3 |

Assignment |Oﬂ SCene v|

(=) Off Scene (D)

O Scene (9)
+-[ Command Past (1)
+-[ Fire &ttack Group (4)
+-[7) Wentilation Group (3
+-[ Water Supply Group (1)

Menu | Sync

»The IC syncs the Mobile Unit. < 9

»The Water Supply Group and Ventilation Group appear in
the layout area of Command. <«

0 -Responders 0 -Responders 1-Responders (5) 1-Responders (1) 0 -Responders (3)
0 - Equipment 0 - Equipment 1-Equipment (2} 1 - Equipment (1) 0 - Equipment (1)
0 - Patients 0 - Patients 0 - Patients (0) 0 - Patients (0) 0 - Patients (0)
B Lewis, carl A Hodge, Howard = @ MFD-WE1-01-T3NW {3}
RMFD C1Suburban [C1-08] RMFD-TW2-03-T1 [MFD-TW2-03-T1] a Hodge, Helen
a Hogg, Jean
a Sharpa, Billy
B  Fire Attack Group @ R MFD-WE 01 T3NW [MFD-WEL-01- T3]
0 -Responders (4)

0 - Equipment (1)
0 - Patients ()]
El@ MFD-E1-01-T1(4)
A D=Rosa, Nick
a Earley, Tarry
aEmith. George
B Wentworth, Murisl

M FD-E1-01-T1[MFD-E1-01-T1]
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»The IC clicks, drags and drops the Water Supply Group
and the Ventilation Group on the Command Post
Assignment. «

B Command Post

0 -Responders 0 -Responders 1 -Responders (9)
0 - Equipment 0 - Equipment 1 - Equipment (4}
0 - Patients 0 - Patients 0 - Patients (0

B Lewis, Corl
R MFD C1Suburban [C1-08]

B  Fire Attack Group om= Ventilation Group =2 Water Supply Group

0 -Responders (4) 0 -Responders (3) 1-Responders (1)

0 - Equipment (1) 0 - Equipment (1) 1-Equipment (1)

0 - Patients (0) 0 - Patients (0) 0 - Patients (0)

E'@ MFD-E1-01-T1 (4] = @ MFD-WE1-01-T3NW (3} a Hodga, Howard

a DeRaoss, Nick a Haodge, Helen M FD-TW2-03-T1 [MFD-TW2-03-T1]
B Earley, Terry A Hogg, Jean
B smith, George B sharpe, Eily
aWentwodh. Muriel W MFD-WE1-02-T3NW [MFD-WE 1-01-T3MW]
WMFD-E1-01-T1 [MFD-E1-01-T1]

»The Timer Expires. There i1s an audible alarm and the
Restart Timer screen appears. The IC clicks on Yes. «

iBix

5 @ @ -- EXPIRED TIMERS --

BACK  RESTART ALL CLEAR ALL

The following timers have expired. Check each irmer to clear or restart it

Assignrment/Company | Mate | Expired | Tota Time |
Fire Attack Group Attack started 2/25/2010 20 minute. ..

Restart Timer x|
? ) ‘iould vou like to restart this timer?

Yes Mo | Cancel |
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» The IC calls for a PAR. He clicks on Incident> Par
Count and the Par Count screen appears. He checks the
box for the Command Post. The IC then calls for a PAR
from each Assignment and checks the box 1f the count
matches the count in Command. When complete the IC clicks
on Save. <

Best Practice for calling for PAR is to ask each assignment to give you

the number of responders that they have in PAR rather than asking

them if they have the number that is shown in Command.

e
S (© - PAR COUNT --
BACK SAVE

PAR | Assigniment |
b1 Command Post

4 MFD-E1-01-T1

3 MFD-WEIL-01-T3MWY

1 ‘\Water Supply Group

»The IC calls dispatch and asks that Mutual Aid be
dispatched. «
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»The Ambulance arrives. The IC does not have an
Assignment barcode for Rehab so he manually adds it. He
taps on Menu2>Add->Assignment to add the Assignment. He
types 1In the Name, chooses the level from the dropdown

and clicks on OK. «

"y | MOBILE : ‘& | MOBILE
Q, Timer par [0 | Assignment
Assignment |On Scene -|
[ Off Scene (0) Name |REH.-5.EI| |
E8m] On Scene (9] Level |Elrar‘u:h "l
1231[2]3]4

[s[6]7[8][o]0]-[=|«
Tablalwle|r[t[y[u[i]o]p|I
caPla[s[d[f[a[n]i[k[I]:]"
shiftfz[x[c[¥[b[n[m[, [.]
cHlai] " [\ ] [+]1

3

Add 3  MNew Company
Details »| Company

Find 4 Assignment

Menu| | S¥nc

»The IC scans the equipment barcode and the personnel
barcodes for the Ambulance.< 10

»The IC syncs the mobile unit. < 11
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»The IC clicks, drags and drops REHAB on the Command Post

Assignment. «

0- Responders
0- Equipment

0- Patizms

Off Scene
0 - Respondzrs
0 - Equipment
0 - Patiants

0 - Patiznts

B Command Post

1- Responders (11)
1 - Bguipment (5]

o

Bievie, co

W7D C1 Suturtien [C1-08]

B  Fire Attack Group
0 - Respondars (4]

L]

= Ventilation Group

0- Respanders (3)

B  Water Supply Group
1-Responders (1)

= REHAB

2-Respenders (2)

B Wertiwrtn, Vst

0 - Bquipment (1) 0- Equipment (1) 1 - Bquipment (1) 1 - Equipment (1)
0 - Patients (0] 0 - Patients (0 0 - Patients ()] 0 - Patients (0
B@ MFD-EL-03-TL (4) Ev MFD-WEL-OL-TINW (3) fyEronn, Donsia B rotm, Howard
B Defoma, tick B ratze, Heien ) Santierzon, Geoffrey WRMFD-TW2-E-T1 [MFD-TW2-I3-T1]
B ey, Tery Bz 3o WSS AMET04TS [MEMS-AMEZ-04 T3]
A smith, Gearge A S, By

W MFDWEL-1-T3HW [MFD-WEL-01-TINW]

W FD-EL-01-TH [MRD-E-0 T

»The Law Enforcement Units arrive.
Law Enforcement Assignment.

the

equipment and responder barcodes. <« 12

The IC manually enters
He then scans the

:.‘. | MOBILE

Assignment

Name |Law Enforcement |

Level |Elranch

1231][2[3]4]s][a[7[8]9]0]-[=]«

Tabla[wle|r[t]y[ufi[o]p[[]]

capla[s[d[f]a]n]iJk]1]:]"

|
—

shift| z [ [c[v][b[n[m[,[.[/]
culai] " [ ] [L[1]<]>

:.‘. | MOBILE

Q, Timer |00:00:00] paR |15 |

Assignment |Law Enfarcement

+- Command Post (1)
+\7 Fire &ttack Group (4)
+ ([ REHAE (2)
+1 Wentilation Group (3
+107 Water Supply Group (1)
- Law Enforcement (4)
Carothers, Richard
Gossard, Glenna
Grile, Andrew
Stuckey, Kathleen
R ASP-YEH1-04 [ASP-WEH1-0
M MPD-YEHZ-06 [MPD-VEHZ-

1il [ T

4]

Menu | Sync

»The IC syncs the Mobile Unit. < 13

20
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»The IC clicks,
Assignment on the

drags and drops the Law Enforcement
Command Post Assignment. <

0 - Responders 0O - Responcers 1 - Respongers
0 - Eouipment 0 - Egulpment 1 - Eoulpment
0 - Patans 0 - Patans 0 - Patanz ey
A s oo
=001 Suornen (22008
Fire Attack Group
Z-Responcers (2}
e
B@ MED-E1-01-TLEE fysrown, Donac

B memzan iz i z2ncersn Gaomey

Rzsregmery 15T A2 - TR SV AN D4

Bzimceen
»The IC receives a call that the utilities have been shut
off. He clicks on the Log tab and checks Utilities in
the Checklist. «

=T

File Incident Report  Wiew  Help
Brost [ oe | Dmar |
7 E -- LOG -- @ -- CHECKLIST --
FILTER ADD EDIT
Log Type I Log Entry | Time ;I Description
User Mave Assignment Yentilation Group To Command Post 2/25/2010 3:20:01 PM O rescue
User Mave Assignment Water Supply Group To Cormmand Post 2/25/2010 3:20:03 Ph [ Exposure
Timer Expired attack started has expired! 2/25/2010 2:24:40 PN O containment
PAR Checked PARCount: Command Post: 1 2/25/2010 3:26:42 P O Extinguishmant
PaR Checked PARCoUNt: MFO-E1-01-T1: 4 2/25/2010 3:26:48 Pl O owerhall
PAR Checked PaRCount: MFD-WE1-01-T3MNW: 3 2/25/2010 3:26:48 Ph O ‘entilation
PAR Checked PARCount: Water Supply Group: 1 2/25/2010 3:26:48 Ph O sakvage
PaR Checked Cornmand Post {1} accounted for 2/25/2010 3:27:028 PN Utilities Off
PAR Checked Fire Attack Group (4) accounted for 2/25/2010 3:27:02 P O Evacuation
PAR Checked MFD-E1-01-T1 (4} accounted for 2/25/2010 3:27:02 P O Scene Security
PAR Checked Yentilation Group (3 accounted for 2/25/2010 2:27:08 Pl O rehab
PAR Checked MFD-WEL-01-T3MW (3} accounted for 2/25/2010 3:27:08 Ph O staging
PAR Checked Water Supply Group (1) accounted for 2/25/2010 3:27:08 Pl

21
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»The IC opens the PAR COUNT screen, calls for a PAR,
checks the assignment PAR counts and clicks on Save. <

il
S - PAR COUNT -

BACK SAVE

Azzignment |
1 : Comrmand Post

4 Law Enforcement

4 MFD-E1-01-T1

3 MFD-WEIL-01-T3NW
2

1

.
-
el

FEHAB
Waater Supply Group

EEEREE

»The Mutual Aid department, Redrock FD, arrives with a
Command Vehicle (RFD-C1-03) being driven by the Chief and
4 people 1n an Engine (RFD-E1-02-T2). The Redrock Chief
has an MU (RMS_70) in his vehicle. When they arrive he
starts Mobile software on the MU and starts a new
incident.

The IC gives the Redrock Chief the assignments for his
department’s responders. The Redrock Chief will be
functioning as the Safety Officer and the responders on
the Engine will be assigned to Fire Attack.

The Redrock Chief scans the Safety Officer assignment and
his equipment and responder barcode. <« 14 (Redrock
Chief)
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» The Redrock Chief forms a Company for his Engine.

e He types iIn the Fire Attack Group Assignment barcode
and scans the equipment barcode.

e He highlights the equipment and taps on the icon in the
upper left corner.

e The Form Company screen appears and he taps on Yes
e He scans the Responder barcodes

e To add each Responder to the Company he highlights the
responder and taps on the icon in the upper left
corner.

e The Details screen appears
e He chooses the Equipment/Company from the Assignment
e dropdown and taps on OK.

e The Company screen appears and he taps on Yes. <« 15

(Redrock Chief)

okl e | i LT
‘e | MOBILE *e | MOBILE ¥ o 106

Q, Timer [00:00:00] par [1 | Q, Timer [00:05:00] PaR L]
Assignment [Fire Attack Group M Assignment |Fire Attack Group hd
[ Off Scene ()
=+ On Scene (1] - C?_ would you like to form a
-1 Safety Officer (1) Cormpany’?
Lewwis, Larry

B RFD-C1-03 [RFD-C1-03]
--[ Fire &ttack Group (0)

L _RFD-E1-02-T2 [RFD-E1-02-T2

T T Lllul_J.u'Tc

4 Il [T 4] I [T»
Menu | Sync Menu | Sync

‘s | MOBILE

F} | MOBILE

Q Timer |DD:DD:DD| PAR |5 | Details

Assignment  [RFD-E1-02-T2 M

On Scene
) Off Sene (0) Mame BelotgDff Scene

- Rank  Fire Filfire Attack Group
5 On Scene (3] RFD-E1-02-T2
-1 Fire &ttack Group (4) Org  Redrogafety Officer

Assignment |Fre Attack Group -]

Belote, Kandi

Clifford, David Ciescription | Activity Date |
Earley, James Fire Attack Group 2f25/10 4:08:45 PM
Walker, Brian

-8 RFD-E1-02-T2 ()
W RFD-E1-02-T2 [RFD-E1-02
+-[ Safety Officer (1)

History ‘ Qualifications ‘
o4 i [ [»
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e | MOBILE

. “" .
O

Assignment |Fre Attack Graup -]

[ Off Scene (D)
=1 On Scene (5)
-1[C Fire Attack Group (4)
SR ARFD-E1-02-T2 (4)
Y Belote, Kandi
% Clifford, David
'y Earley, lames

( 27 RFD-E1-02-TZis a
; company. Do you want to

joir this resource?

-8 RFD-E1-02-T2 (0] 7% Walker, Brian
) BB RFD-E1-02-TZ2 [RFD-E1-02 B RFD-E1-02-T2 [RFD-E1-03
+-|5) Safety Officer (1) +-1 Safety Officer (1)
4] ] [ T¢» 4] i [ T#
Menu | Sync Menu | |5"_|I'I'IE|

»The Redrock Chief then calls the IC for permission to
sync his MU to the Moosewood Command software. <

»The IC responds that the Redrock Chief should sync
whenever convenient during this incident. <«

»The Redrock Chief syncs the MU with Command. <« 16

»When the Add Device Incidents screen appear the 1IC
checks the box to accept the Redrock Mobile Unit. He
looks at the Device Name and the Incident Number <«

x
5 @ -- ADD DEVICE INCIDENTS --
BACK SAVE
Device Name | Device UID | Incident ID| Incident MName | Incident Number| I Progre
FO 5 001346E004EB01089EFFF/ES... 3 True
4| | B
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»The IC clicks drags and drops the Safety Officer
Assignment on the Command Post Assignment. The Redrock

Responders appear in the Fire Attack Group Assignment. <

= Command Post

o s ——

&=  Fre Attack Group ) Ventiiation Group
0-Remoncets  (E) [REre—— 4-Remomcets (4] 1 -Resmoncers (1) - Femoncess  (2)
O-Eodement () 0-Equpment (1} 2-Egdement () 1 -Equpmest (1) 1 - Equdpment (1}
0-Pruens @ 0- Patens )] 0-Pruens @ 0-Fatens () 0-Faens ()
B@ MFD-E1-01-T1E0 B@ MED-WEL-01-TINWE B cxromers R . {4 3rown. Donze
a Ddiogs, Mick B Hooge, Haian D TAE-03-TL[MFD-THE- BT ﬂcoazt,c =Te =0 C1- 03 [RFD-CE] ﬂsrn:ew'\,ceo"w
Az e . B cotie, sz =5 A2 04 T3 [MEME- AMBE- 04T
P P P ﬂs—.nzr,enen
- WEL- DL TN MR- WEL-DETE ST B B AR
D VES 05 [ D V0

»Redrock unit RFD-WE1-99-T4NW 1is sent to Staging.
Redrock Unit RFD-TW2-97-T1 arrives and is assigned to the
Water Supply Group. The Redrock Chief scans the

barcodes. 4«17 (Redrock Chief)

»The Redrock Chief syncs his mobile Unit. « 18

T
0-Responcers (2] 0-Rasponcers (3 z- 2 @
0-Equdpment (2} 0-Equpment (1) = 1-Equipment (1)
0-FPatients (0] O-Fafiests (0} O-Famens (0D
B eeicinin B e imzonca Byzemn, ozt

B ik Braton, i Pzt sty

Wmrr Ty Ao e =z oa T e A zoeTy]

B = [ Rt

Byemrtnh, rurd T DT I (MRS N]

T [T
Btz

Pz vt

Wcird, cod

P somn

Preck, 2o

Tz R
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»The IC assigns the Moosewood Company MFD-E1-01-T1 to
Rehab. He chooses REHAB from the dropdown and scans the

barcode. €19

»The IC syncs his Mobile Unit. <« 20

»The IC opens the PAR COUNT screen, calls for a PAR,
checks the assignment PAR counts and clicks on Save. <«

~-loi x|
9 () - PAR COUNT --

BACK SAVE

FAR. | Assignment |

41 Command Post

4 Law Enfarcement

4 MFD-E1-01-T1

3 MFD-\WEI-01-T3IMW
2 REH&E

4 RFD-E1-02-TZ2

1 Safety Officer

2 Staging

2 Water Supply Group
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» The
Rehab.

IC anticipates sending additional
He receives a report that several responders may
assistance so he checks to see who on the

need medical

scene may assist iIf needed and has the qualifications of
on Report>Responder Qualifications,

EMTP.

He clicks
checks EMTP, and clicks on Save. <«

responders to

o

BACK PRINT

-- RESPONDER QUALIFICATION REPORT --

Qualification

| -

[ms]

O ARSONT
O orRs

O erT

O EmMT_
O EMT_F
EMTP
O EVIDENCE
OFFI
OFFn
OFr

O FrFIL
OForn
O For

O Fou

[ HazMaTT
O HazT
O Hwma

O Hwo

[ HMT
Oiwc
OicTz

L)

=4

»The Responder Qualifications report appears giving the
IC information on which Responders on scene have the EMTP

qualification as well as their current assignment. <

ol
File
Responder Qualification -- REPORT -- @ COMMAND
Name Assignment Qualifications
EMT, EMT_, EMT_P, EMTP, FF_I, FF_II, FFL, FFII, FO I_II, FOL, FOIL, HMA, HMO, MFR, 50,
Barley, Tery | MFD-EI-OL-TL | geid SweG 1 WO T, WROL WrROT
Wentworth, MED-E1-01-T1 EMT, EMTP, FF_I, FF_IL, FFL, FFIL, FO 1_II, FOI, FOII, HAZT, HMA, HMO, HMT, MFR, VEHX,
Muriel WFO_I, WFO_IT, WFDI, WFOII
AQ, ARSONT, EMT, EMT_, EMT_P, EMTP, FF_I, FF_IL, FFI, FFII, FO L_II, FOI, FOII, HAZMATT,
Lewis, Carl Command Post | HAZT, HMA, HMO, HMT, IC, ICT3, INVEST, MFR, SO, 50T3, VEHX, WFO_I, WFO_IL, WFOL,
WFOII
Hocge, Helen | MFD-WEL-01- AQ, ARSONT, EMT, EMT_, EMT_P, EMTP, FF_L, FF_II, FFI, FFIL, FO _II, FOI, FOIL, HMA,
' TaNW HMO, Ic, TNVEST, MFR, P10, PIOT3, 50, VEHX, WFO_L, WFO_II, WFOI, WFOII
Hoga, Tean MFD-WE1-01- EMT, EMT_, EMT_P, EMTP, FF_I, FF_II, FFI, FFII, FO 1_II, FOL, FOII, HAZT, HMA, HMO, HMT,
" TINW MFR, P10, VEHX, WFO_, WFO_II, WFOI, WFOII
Stuckey, Law ARSONT, EMT, EMT_, EMT_P, EMTP, EVIDENCE, HAZMATT, HAZT, HMA, HMO, HMT, IC,
Kathleen Enforcement INVEST, MFR, PIO
Grile. Andrew | B¥ ARSONT, EMT, EMT_, EMT_P, EMTP, EVIDENCE, HAZMATT, HAZT, HMA, HMO, HMT, IC,
' Enforcement INVEST, MFR, PIO
Belote, Kandi RFD-E1-02-T2 EMT, EMT_, EMT_P, EMTP, FFL, FOIL, HMA, MFR, VEHX, WFOI
Earley, James | RFD-E1-02-T2 EMT, EMT_, EMT_P, EMTP, FFL, FFII, FOI, FOIL, HMA, HMO, MFR, 50, VEHX, WFOIL, WFOII
Lopez, Ann Staging EMT, EMTP, FFI, FFII, FOI, FOII, HMA, HMO, MFR, VEHX, WFOT, WFOII

B
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»The IC receives a report that the fire is out. The IC
clicks on the Log tab and the Add button. The ADD LOG
ENTRY screen appears. The IC types in Fire is Out and
clicks on Save. <«

@ COMMAND - Fire 300 South Summit Street

Fle  Incident Report Wiew  Help

Elrost = wos |@Mnr |

i S -- LOG --
FILTER ADD
x|
jLogT i

Lser 5 6 -- ADD LOG ENTRY --

Incick  gack  save
Devic

Time
P&R ¢ *Log Text IFire Qut
PAR €

P&R i~ L= 0 L 2 0 el B . et . =

—r

»The IC releases the State Police unit. He chooses the
Off Scene assignment from the Assignment dropdown and

scans the equipment and responder barcodes. €21

»The IC releases the two Redrock units. The Redrock
Chief chooses the Off Scene assignment from the
Assignment dropdown and scans the equipment and responder

barcodes. 4 21 (Redrock Chief)

»The IC syncs his Mobile Unit €22

S PR
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»The IC releases MFD-E1-01-T1 to return to their station
and MFD-WE1-01-T3NW to REHAB. He chooses the assignments

and scans the barcodes. €23
»The IC syncs his Mobile Unit €424

[FE——
) s Gaera
S PR

»The IC releases RFD-E1-02-T2 and the Safety Officer to
return to theilr station. He chooses the assignment and

scans the barcodes. 425 (Redrock Chief)
»The IC svncs his Mobile Unit €426

- Ampoiey  (14)
a- et ()
G - PalicnCy [1-1] o
| [« Waen

I FT S Sdertan [DI-00]

B amy
Bicraz aom
Bicraz utact
Iﬁﬂ'__ﬁ L
Babar, Coaid I-Ampize (3]
Lot (1]
0 - Palerts [i:1}
B carztrans, miman
ﬁ-::-ru G
Em&xr_,-:l-c-l-n w DG [TV AR o T [P AR -T2
EM‘-E—'.‘.II-QI-E‘-‘.‘.‘ @

E#r_,-:l-oc-n o

m

1 - Ropodoa (1)
SP-VEH-O AP 04 Lt (1
o - Padcrly i1

0L [FRTCI-0G]

ﬂ-:qgu. zeand

FFC-TWI-57-T1 [RFO-TWI=45-T1]
FT-TAGHG-TI [MFT-TW3-0G-T1]

AR -THAY [FROARL-GG-THR]

ﬂ-:dgﬁ e
!-:m Jaam
ﬂi‘uﬁ -

TR0 TR MRT-WEL -0 Tl
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»All units have been released. The IC chooses the Off
Scene assignment and scans the barcodes. €427
»The IC syncs his Mobile Unit €28

12 - Rasporcers (23]
7 -Egdpment  (L0)
0 - Pamars {00

{8 Eroun, Donac

ﬁc: rosars, B

Py =

B crite, acrmn

a Hoige, Mo

a LS, Cari

a L, Larry

a Lopez, Ann

a Loz, Rokbert

ﬂs.:'-ce'm-'u,.ﬁaa'tq-

{8 Sty Kt

a?.z Do

SE7-VEH L0 [ ASP-VERLCH]

MG AMEE- O T2 [MEME-AMEZ-H-TE]
T TG -0G3-TL[MFD-TREETI]

R PT-VEHE-0s [MPD- VR
A0 CL-03 [RRD-OHE]
FFC-THE-S7-TL [RFD-TRESFTI]
RO NEL-S2- THNW [FFD-IWE RS TN

E@ MFD-E1-01TLR
E@ MFC-WE-0L-THN T
E@ RFD-EL-02-T200

»End the Incident on the Mobile and Command Software. <
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3 Barcodes for the Scenario

Barcodes for the Scenario using Mobile & Command

This chapter contains actual barcodes used in the Scenario using Command section. These barcodes
may be used, along with Mobile Units and Command software, in conjunction with the scenario. There
are numbers in the scenario that correspond with numbers in this section to allow you to more easily

follow along.
e.g., 1 SCAN, 2 SYNC

1 SCAN
Moosewood Fire Department
® MFD-E1-01-T1
A ‘ | MFD-E1-01-T1
Sl Ly !
| R e |
Moosewood Fire Department Moosewood Fire Department

Y

I | ‘ I
Nick DeRosa Terry Earley

Assistant Chief Fire Fighter
50250-500815 50250-581117

fireTRAYX ™ fireTRAX ™

|

I‘ F.
'
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Moosewood Fire Department

Muriel Wentworth
Fire Fighter
50250-700901

fireTRAYX ™

oot

Moosewood Fire Department

George Smith
Driver
50250-401022

fireTRAX ™

|

2 SCAN

e |

On Scene

Moosewood Fire Department

Moosewood Fire Department
S AWEm MFD-C1-06

: | MFD-C1-06

2006 Chevrolet Suburban

mmmwmmm%mm@m%%mﬁm

Carl Lewis
Fire Chief
50250-550704

fir eTRAX ™

§
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w
o))
<
Z
O

N
@]
O
>
Z

Assignment

ehaisiae |

Command Post

Moosewood Fire Department
SRR MFD-C1-06

LW B MFD-C1-06

2006 Chevrolet Suburban

||nmmmmmmmmﬁm I

Assignment

s st ||

Fire Attack Group

Moosewood Fire Department

Carl Lewis
Fire Chief
50250-550704

fireTRAX ™

fo

¥ 1%
S vFo-E1-01-T1
9P B MFD-E1-01-T1

Moosewood Fire Department

N%LWWH%M%MHW%M%%M
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Assignment

sttt |

Water Supply Group

L b Moosewood Fire Department

R MFD-TW2-03-T1
> ‘ MFD-TW2-03-T1

TN T |

Moosewood Fire Department

Howard Hodge
Fire Fighter
50250-700506

fireTRAYX ™

b

7 SCAN (forming a Company)

L | ‘ ; ‘i,

SR MFD-WE1-01-T3NW
i ‘ MFD-WE1-01-T3NW

L

Moosewood Fire Department

i |
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Moosewood Fire Department

o .. ¥

-..I-;

L

I"f'u o 1 ‘
L &
2 | !
- 5

4

Helen Hodge
Captain
50250-550804

fireTRAYX ™

ek

Moosewood Fire Department

Jean Hogg
Fire Fighter
50250-820628

fireTRAX ™

L

Moosewood Fire Department

N

)
L
¥ A :
i) b}
&

Billy Sharpe
Fire Fighter
50250-600202

fireTRAX ™

e e |

8 SCAN

Assignment

e e )

Ventilation Group

e

& ‘

Moosewood Fire Department
MFD-WE1-01-T3NW

PR B MFD-WE1-01-T3NW

R |
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9 SYNC

10 SCAN (assignment has been manually added to the mobile unit)

Moosewood EMS

Donald Brown
EMT Basic
EMSMEMS DDB1970

eTRAY ™

sl

m Moosewood EMS

MEMS-AMB2-04-T3
MEMS-AMB2-04-T3

T st |

Moosewood EMS

Geoffrey Sanderson
EMT Basic
EMSMEMS-GDS1955

fireTRAYX ™

Jeliaiia |

11 SYNC
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12 SCAN (assignment has been manually added to the mobile unit)

.. Alaska State Police

ASP-VEH1-04
ASP-VEH1-04

RS R |

Alaska State Police

Kathleen Stuckey
Lieutenant
LAWASP-KCS1977

fireTRAX ™

|

Alaska State Police

Andrew Grile
Trooper
LAWASP-AAG1960

fireTRAX ™

Ja |

Moosewood Police Dept
MPD-VEH2-06
MPD-VEH2-06

T i et
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Moosewood Police Dept Moosewood Police Dept

el |ef

Glenna Gossard Richard Carothers
Officer Lieutenant
LAWMPD-GGG1970 LAWMPD-RNCI1965
fireTRAX.TMI B , fireTRAX.TMI B
gt |l o |
’ l l n'HenY S i. | I r
13 SYNC

14 SCAN — REDROCK MOBILE UNIT

Fire-Trax Assignment

Safety Officer

R |

Redrock FD

M Redrock FD
TN RFD-C1-03

QRS RFD-C1-03

T[ i
[ e i Y Larry Leuwis
SAas0L W 1956

|z
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15 SCAN (forming a Company) - REDROCK MOB“_E UN'T

Redrock FD
RFD-E1-02-T2
RFD-E1-02-T2

bt A

Redrock FD

Kandi Belote
Fire Fighter
53450-KMB1955

fireTRAYX ™

sl

Redrock FD

David Clifford
Assistant Chief
53450-DIC1970

fireTRAYX ™

ekl

Redrock FD

James Earley
Fire Fighter
53450-JLE1950

fireTRAYX ™

Jachai|

Redrock FD

Brian Walker
Captain
53450-BMW1970

fireTRAYX ™

fo |
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16 SYNC — REDROCK MOBILE UNIT
17 SCAN — REDROCK MOBILE UNIT

Assignment

s |

Staging

Redrock FD

RFD-WE1-99-T4NW
RFD-WE1-99-T4NW

NIRRT R ]

Redrock FD Redrock FD

Ann Lopez Robert Lopez
Fire Fighter Fire Fighter
53450-AML 1980 53450-RIL1978

ireTRAX T™ fireTRAYX ™
]

] JEREEEREA
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Assignment

i e )

Water Supply Group

Redrock FD
RFD-TW2-97-T1

_._[.--I'i_f:"['— RFD-TW2-97-T1

ﬁ%ﬁ%ﬁ%ﬁ%@ﬁ%ﬁ%ﬁ%m

o

Redrock FD

| Donald Walker
Driver
53450-DMW1980

fireTRAYX ™

Jiesll

18 SYNC — REDROCK MOBILE UNIT

19 SCAN (Choose Rehab from the Assignment dropdown)

S vFD-E1-01-T1
v L ‘ MFD-E1-01-T1

Moosewood Fire Department

[ |
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20 SYNC

21 SCAN (Choose Off Scene from the Assignment dropdown)

Alaska State Police

ASP-VEH1-04
ASP-VEH1-04

et |

Alaska State Police Alaska State Police

Kathleen Stuckey Andrew Grile
Licutenant Trooper
LAWASP-KCS1977 LAWASP-AAG1960

fireTRAX ™ fireTRAX ™
i

| || RS
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Redrock FD

Redrock FD

RFD-TW2-97-T1
RFD-TW2-97-T1

et AR |

Donald Walker
Driver
53450-DMW 1980

fireTRAX ™

Jisll

Redrock FD

RFD-WE1-99-T4NW
RFD-WE1-99-T4NW

et |

Redrock FD Redrock FD

Ann Lopez Robert Lopez
Fire Fighter Fire Fighter
53450-AML1980 53450-RIL1978

fireTRAYX ™ fireTRAX ™

PicEataill | | DEesREERE

22 SYNC
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23 SCAN

(Choose Off Scene from the Assignment dropdown)

l'»_'-_ L W MFD'E1-01-T1
= A ‘ MFD-E1-01-T1

%»-.. 5 }E Moosewood Fire Department

[ |

(Choose REHAB from the Assignment dropdown)

SR vro-wE1-01-T3NW
N i ‘ MFD-WE1-01-T3NW

‘%»__ 2y :l} Moosewood Fire Department

e |

24 SYNC

25 SCAN (Choose Off Scene from the Assignment dropdown)

Redrock FD
RFD-E1-02-T2
RFD-E1-02-T2

it |
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Moosewood Fire Department

IR MrFD-c1-06
LR B MFD-C1-06

. % ol | 2006 Chevrolet Suburban
||||mm&mmm&mmmm
26 SYNC

Redrock FD

Larry Lewis
Fire Chief
53450-LWL1956

fireTRAX ™

el

27 SCAN (Choose Off Scene from the Assignment dropdown)

Moosewood Fire Department

SCTRIE MFD-WE1-01-T3NW
9P § MFD-WE1-01-T3NW

mmmmwmmmmmﬁwmwmﬁm

Moosewood Fire Department

" RUE MFD-TW2-03-T1
‘9P § MFD-TW2-03-T1

W%MMWW%%@M%%MW%%N

45

Moosewood Fire Department

Howard Hodge
Fire Fighter
50250-700506

fireTRAX ™

[




Moosewood Police Dept

MPD-VEH2-06
MPD-VEH2-06

[ i e |

Moosewood Police Dept

Glenna Gossard
Officer
LAWMPD-GGG1970

fireTRAYX ™

Jelgiiany |

Moosewood Police Dept

Richard Carothers
Lieutenant
LAWMPD-RNCI1965

fireTRAX ™

|Gl

ALY T PP

Moosewood EMS

; MEMS-AMB2-04-T3
2, MEMS-AMB2-04-T3

| {liae it il Rt
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Moosewood EMS

iy

Donald Brown
EMT Basic
EMSMEMS-DDRB1970

fireTRAYX ™

Moosewood EMS

iy

Geoffrey Sanderson
EMT Basic
EMSMEMS-GDS1955

fireTRAX ™

Jiskei |

Moosewood Fire Department

Carl Lewis
Fire Chief
50250-5530704
fireTRAX ™™

i ak ] inH

il

28 SYNC

End the Incident on the Mobile and Command Software.
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